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Einspielungen mit der 
Mehrspurmethode

Der folgende Artikel beschreibt Versuche der russischen ITK-Vereinigung RAIT, bei denen 
eine Mikrofon-Einspielung mit Hilfe des Computers mehrfach hintereinander auf akustischem 

Wege „überspielt“ wird, wodurch die erhaltenen Stimmen verstärkt werden sollen. 

VON ARTEM V. MIHEEV UND VADIM K. SVITNEV 

ie Erfor-
schung
des Ton-

bandstimmen-
Phänomens , 
das im 20. 
Jahrhunder t  
von Friedrich 
Jürgenson entdeckt wurde, hat ei-
ne Geschichte von etwa 50 Jah-
ren. Im Allgemeinen können alle 
Methoden der Stimmenaufnahme 
in drei Gruppen aufgeteilt wer-
den: die Mikrofonmethode (Jür-
genson), die Radiomethode (Jür-
genson, Raudive, Franz Seidl, 
Marcello Bacci, etc.) und die 
Aufnahme mittels spezieller Ge-
räte (George Meek, Hans Otto 
König, Jules und Maggie Harsch-
Fischbach, u. a.). Leider sind die 
Möglichkeiten der ersten zwei 
Methoden sehr beschränkt, und 
spezielle Geräte sind unzugäng-
lich für die meisten Anwender 
und hängen stark vom menschli-
chen Faktor (Experimentator) ab. 
Unserer Meinung nach besteht 
das Ziel der Forschung heute in 
der Suche nach einem Kompro-
miß zwischen der Wirksamkeit 
der Methode und ihrer Zugäng-
lichkeit. In diesem Artikel möch-
ten wir eine Methode darstellen, 
die von uns 2008 ausgearbeitet 
wurde. Für die Stimmenaufnahme 
benötigt man: 

1. Einen Computer oder Laptop 
mit dem Betriebssystem Win-
dows XP, 

2. Eine Soundkarte, die gleich-
zeitiges Aufnehmen und Wieder-
geben unterstützt (Full Duplex), 
erkennbar an den Mixer-
Eingängen „Mono Mix“ oder 
„Was Sie hören“. 

3. Das Audiobearbeitungs-Pro-
gramm Cool Edit Pro oder dessen 
Nachfolger Adobe Audition. 

4. Ein Mikrofon, das an den 
Mikrofon-Eingang der Soundkar-
te angeschlossen wird – erforder-
lichenfalls über einen Vorverstär-
ker.

Vorbereitung
Zuerst werden aus einer Fremd-

sprachenmischung „Konserven“ 
hergestellt. Eine Aufnahme mit 
der Mischung von vier oder fünf 
Rundfunksendern, geprüft auf 
mögliche Übereinstimmungen 
mit der Muttersprache, ist gut ge-
eignet. Wenn solche gefunden 
werden, werden sie mit Hilfe ei-
nes Sound-Editors entfernt. Diese 
„Konserven“ werden als mp3-
Dateien gespeichert dort, wo man 
auf sie schnell zugreifen kann. 
Dann öffnet man in der Sy-
stemsteuerung den Punkt „Sounds 
und Audiogeräte“ und wählt die 
Option des internen Mischers der 
Soundkarte „Mono (stereo) Mix“ 
oder ihre Entsprechung „Was Sie 
hören“. Der Lautstärkeregler des 

internen Mischers wird auf das 
Minimum eingestellt, die Laut-
stärkeregler der Wiedergabe und 
des Mikrofoneingangs – auf das 
Maximum. An den Mikrofonein-
gang wird ein Elektret-Mikrofon 
mit eigener Stromversorgung an-
geschlossen. Über Mikrofon wer-
den Fragen gestellt, es stellt zu-
dem einen schwachen Rauschträ-
ger zur Verfügung, der nach un-
seren Erkenntnissen für die Erzie-
lung des Effektes nötig ist. Wenn 
die Signalstärke ungenügend ist, 
wird ein Mikrofonverstärker be-
nutzt.

Aufnahme
Mit Hilfe des Standardpro-

gramms Windows Media Player 
wird die mp3-Datei mit der 
„Konserve“ auf „Wiedergabe“ 
geschaltet. Die Lautstärke des 
Windows Media Players wird 
entsprechend eingestellt (15 bis 
20 % in unseren Experimenten). 
Wenn nötig, wird die Lautstärke 
des internen Mischers der Sound-
karte eingestellt. Die Lautstärke 
der „Konserve“ sollte ungefähr so 
sein, daß sie bei der Aufnahme 
etwa ¼ der maximalen Amplitude 
einnimmt (Amplitude des Si-
gnals, bei der sie aufhört anzu-
steigen und zurückgeht). Um den 
Jenseitigen eine ausreichende 
Phonembasis zur Verfügung zu 
stellen, kann man die „Konser-
ven“ nicht von Anfang, sondern 
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von einer anderen Stelle an ab-
spielen. Nach dem Start der Wie-
dergabe wird das Programm Cool 
Edit aufgerufen,und durch die Be-
tätigung der Taste  links 
oben in den Mehrspur-Modus 
umgeschaltet. Für eine monopho-
ne Mehrspuraufnahme mit Echt-
zeit-Überlagerung wählt man im 
Menu „Options> Settings> Multi-
track“ die Einstellung „Track Re-
cord > 16 bit mono“ und setzt im 
Menu „Effects“.einen Haken bei 
„Sample Accurate Sync“. 

Wählen Sie die Spurlänge (die 
optimale Zeit für die Aufnahme 
einer Spur beträgt 20 bis 40 Se-
kunden). Betätigen Sie die rote 
Taste  gegenüber der ersten 
Spur und starten Sie die Aufnah-
me mit der Taste  („Record“) 
unten. Nach dem Start der Auf-
nahme der ersten Spur stellen Sie 
Ihre Frage über Mikrofon. Um 
der anderen Seite die nötige Zeit 
für eventuelle Antworten zur Ver-
fügung zu stellen, sollte Ihre Fra-
ge nicht länger als 10 Sekunden 
dauern. Nachdem die Aufnahme 
der ersten Spur abgeschlossen ist, 
drücken Sie auf die Stopptaste 

. Betätigen Sie dann nochmals 
die Taste  auf der ersten Spur 
und dieselbe Taste gegenüber der 
zweiten Spur. Starten Sie wieder 
die Aufnahme mit der Taste .
Wenn Sie alles richtig gemacht 
haben, beginnt die Aufnahme des 
Signals auf der zweiten Spur mit 
der Überlagerung des Signals der 
ersten Spur. Die Dauer der Auf-
nahme auf der zweiten Spur sollte 
ungefähr so sein, wie auf der er-
sten. Nach dem Abschluß drük-
ken Sie auf die Taste . Dieser 
Vorgang wird viermal wiederholt. 
Bei der vierten Überlagerung er-
reicht die Amplitude ihr Maxi-
mum. Das Ergebnis sieht unge-
fähr so aus wie auf obiger Abbil-
dung.

Bemerkung 1: Wenn Sie mehr 
als vier Spuren nehmen, wählen 
Sie eine andere Ausgangslaut-
stärke der „Konserve“. 

Bemerkung 2: Obwohl die 
Verfasser dieses Artikels nach ei-
ner möglichst einfachen Darstel-
lung streben, ist es keine erschöp-
fende Anleitung zur Anwendung 
von Cool Edit Pro und Adobe 
Audition. Für komplette Informa-
tion empfehlen wir Ihnen das Hil-
fe-Menü oder entsprechende Lite-
ratur.

Bemerkung 3: Während der 
Aufnahme sollten Ihre Lautspre-
cher (Kopfhörer) ausgeschaltet 
sein.

Abhören und Bearbeitung 
Da Ihre Frage über Mikrofon 

auf der vierten Spur nicht immer 
gut hörbar ist, empfehlen wir Ih-
nen, zuerst die erste Spur aufzu-
rufen, Ihre Frage abhören und 
sich die Zeit auf der Zeitskala zu 
merken, wann sie zu Ende ist. Die 
eventuelle Antwort befndet sich 
auf der vierten Spur. Sie wird 
durch Doppelklick mit der linken 

Maustaste auf der Spur oder 
durch Doppelklick mit der linken 
Maustaste im Trackmenu links 
aufgerufen (s. Bild). In dieser 
Stufe können Sie diese Spur ohne 
Bearbeitung abhören. Die Ant-
wort folgt oft unmittelbar der 
Frage und sticht deutlich von dem 
allgemeinen Redehintergrund ab. 
Wenn Sie sicher sind, daß Sie ei-
ne Antwort bekommen haben, 
können Sie dieses Fragment mit 
der Maus markieren und es mit 
Hilfe von „Noise reduction“ be-
arbeiten (s. unten). Im Fall eines 
Fehlers benutzen Sie die Taste 
(„Rückgängig“) oben. Sollte die 
Antwort wirklich erhalten sein, 
kopieren Sie diese in eine separa-
te Datei („Edit > Copy to New“) 
und speichern sie („File > Save 
As“).

Nachdem Sie die ganze Spur 
analysiert haben, beginnt die 
zweite Stufe der Bearbeitung. Sie 
ermöglicht es, Information he-
rauszubekommen, die beim ein-
fachen Abhören nicht hörbar ist. 

(Fortsetzung auf Seite 25)
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(Fortsetzung von Seite 23) 

Zu diesem Zweck wird die 
Funktion „Effects > Noise Reduc-
tion“ benutzt. Rechts sind zwei 
mögliche Einstellungen ange-
führt. Sie können beide versuchen 
und die beste wählen. Nach der 
Einstellung der Werte (s. Bild) 
markieren Sie die ganze Spur mit 
der Maus, rufen Sie die Funktion 
„Noise Reduction“ auf und neh-
men Sie das Geräuschprofil („Get 
Profile from Selection“). Klicken 
Sie auf OK. Nachdem das Pro-
gramm die Bearbeitung der Auf-
nahme beendet hat, hören Sie sie 
noch einmal ab. 

Bemerkung 4: Vor der Bear-
beitung der Spur durch Noise Re-
duction können Sie alle Frequen-
zen über 4 kHz mit dem FFT-
Filter oder dem grafschen Equali-
zer (Menu „Filters“) abschneiden. 

Variante 1 

Variante 2 

Mögliche Erklärungen 
Die „naivste“ Erklärung dieser 

Methode besteht darin, daß das 
Bewußtsein des Menschen ein-
zelne Sprachfragmente „heraus-
fischt“ und sie bewußt interpre-
tiert. Man muß zugeben, daß die-
es wirklich möglich ist, besonders 
wenn man in jedem Abschnitt der 
Aufnahme Sinn finden will. Aber 
wie die Ergebnisse von Hunder-
ten von Experimenten zeigen, ist 
diese Erklärung weder universal 
noch überzeugend, denn: 

1. Die wirklichen Antworten 
(die meisten bestehen aus einem 
Wort oder einem Satz und ant-
worten auf die gestellte Frage) 
heben sich deutlich von dem all-
gemeinen Sprachhintergrund ab, 
können gefltert und von den Ex-
perimentatoren übereinstimmend 
interpretiert werden. 

Für Tonbandstimmenforschung geeignete Geräte 

Bezugshinweise
Einige der vorstehend aufgeführten Geräte werden speziell für den VTF hergestellt und können von VTF-Mitgliedern unter 
Angabe ihrer Mitgliedsnummer bei den angegebenen Adressen zu einem ermäßigten Preis bezogen werden. Die Preise 
für Nichtmitglieder sind dann jeweils dahinter in Klammern ausgewiesen. Der VTF e.V. steht mit den genannten Händlern 
bzw. Herstellern in keinerlei geschäftlicher Beziehung. Alle Angaben erfolgen daher ohne Gewähr. Für Hinweise auf 
eventuelle Änderungen sind wir dankbar. 

Artikel Preis Bezugsadresse
Hannoversches 
Mikrofon

ca. 40,- € zzgl. Versandko-
sten per Nachnahme 

Hans Krautheim, Bergstr. 37, 32839 Steinheim, Tel. 05233/7170. 

Parabolspiegel hierzu ca. 21,70 € zzgl. Versand-
kosten per Nachnahme 

Firma Albert Meyer Elektronik-Fachversand, Postfach 110 158, 76487 
Baden-Baden, Tel. 07223/52055 (Bestell-Bezeichnung: "VTF-Parabol"). 

Mikrofon 22 89,- € (98,- €) 
Panasonic RQ-2102 49,- € (55,- €) 
Bremer Recorder 119,- € (129,- €) 
Spezial-Kopfhörer für 
Sprache

39,- € (44,- €) 

Filter SV 250 98,- € (109,- €) 
Filter SV 350 249,- € (269,- €) 

Horst Hansen, Mobil-Tel. 0163 / 6661950. Ausführliche Informationen zu 
den Geräten erhalten Sie kostenlos gegen Rückporto (Briefmarke 1,45 €). 

DSP-Filter
LINGUA V12 

228,- € Ing.-Büro Michels, Kolberger Str. 38, 26789 Leer, Tel. 0491 / 
9767397, www.ing-michels.de. 
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2. Die Zahl der Antworten 
hängt vom Zustand und von der 
Stimmung des Experimentators 
ab. Unter bestimmten Bedingun-
gen (unpassende Zeit, Müdigkeit 
des Experimentators) bekommt 
man fast keine oder überhaupt 
keine Antworten, was auch von 
Zuschauern bestätigt wird. 

3. Schließlich, bei der Nichtein-
haltung bestimmter Bedingungen 
ist der Effekt bescheiden oder tritt 
überhaupt nicht ein. 

Betrachten wir andere mögliche 
Erklärungen:

1. Einwirkung auf das Signal 
vom Mikrofon, die auf solche 
Weise geschieht, um bei der Auf-
nahme des „stochastischen“ Pho-
nemmaterials einzelne Phoneme 
zu verstärken oder zu dämpfen. 

2. Ähnliche Wirkung auf die 
Soundkarte.

3. Fehlermanipulation bei der 
Digitalisierung eines analogen 
Signals auf der Soundkarte und 
Aufspeicherung dieses Fehlers 
beim wiederholten Überspielen 
durch den internen Mischer der 
Soundkarte.

4. Einwirkung auf den PC-
Prozessor bei der Bearbeitung des 
Signals (es handelt sich um die 
letzte Stufe – Anwendung der 
Funktion „Noise Reduction“). 

Stellen wir hier einen Vergleich 
mit der Videomethode von Klaus 
Schreiber, der seine paranormalen 
Bilder durch fortlaufende Itera-
tionen bekam, d.h. durch wieder-
holtes Überspielen von Bildern 
vom Bildschirm auf das Band [1]. 

Vergleich mit Stefan Bions 
Programm EVPmaker [2]. 

Wie im Programm EVPmaker, 
wird als Rohmaterial für die Ant-
wortbildung ein quasi-zufälliges 
Sprachsignal benutzt, aber im Un-
terschied dazu erfolgt die Signal-
bildung nicht diskret, sondern un-
unterbrochen. Bei der Anwen-
dung unserer Methode entstehen 
außerdem gut hörbare Stimmen, 
die sich von dem allgemeinen 
Hintergrund abheben und gut ge-
filtert werden können. 

Vorteile der Methode 
1. Unabhängigkeit von Radio-

sendungen und von atmosphäri-
schen Störungen, wie es bei Psy-
chofon- und Radiomethode der 
Fall ist. 

2. Ausschließung von „zufälli-
gen Rundfunksendungen“ (das 
Signal wird nicht abgestrahlt, 
sondern bewegt sich nur inner-
halb der Soundkarte). 

3. Häufge und sinnvolle Ant-
worten.

4. Hohe Verfügbarkeit der Me-
thode und ihre Wirksamkeit (kla-
re, sinnvolle Antworten werden 
praktisch jedes Mal erhalten) 

Nachteile der Methode 
1. In Einzelfällen besteht die 

Möglichkeit einer subjektiven In-
terpretation des Gehörten. 

2. Wenn das Transkommunika-
tionssignal über dem Sprachhin-
tergrund mit ähnlichen Eigen-
schaften liegt, besteht die Schwie-
rigkeit bei der Filterung des Si-
gnals.

3. Kompliziertheit der Methode 
für diejenigen Experimentatoren, 
die mit der geeigneten Software 

nicht vertraut sind. 

Zusätzliche Faktoren 
Wie beim Experimentieren 

festgestellt wurde, haben zusätz-
lichen Faktoren wie z. B. Quarz-
kristalle, Ultraviolettbeleuchtung, 
Metronome, eine rhythmisch 
blinkende Fluoreszenzlampe, ei-
nen positiven Einfuß auf die Ent-
stehung des Tonbandstimmen-
Phänomens, sie sind aber nicht 
unbedingt notwendig Statt des 
Überspielens durch den internen 
Mischer der Soundkarte kann 
auch eine Kombination aus einem 
FM-Transceiver, der die „Kon-
serve“ auf einer unbenutzeten 
Frequenz aussendet, und einem 
Rundfunkempfänger verwendet 
werden, der auf dieselbe Fre-
quenz eingestellt und an den Mi-
krofoneingang der Soundkarte 
des Computers angeschlossen ist. 

Parallelen 
Die Entstehung des Tonband-

stimmen-Phänomen im Computer 
beim Fehlen eines äußeren Mi-
krofonsignals wurde auch von der 
brasilianischen Forscherin Sonia 
Rinaldi festgestellt [3]. 

Hinweise: 

[1] Hildegard Schäfer: Brücke zwischen Dies-
seits und Jenseits, www.rodiehr.de/a_22_ 
bruecke_inhalt.htm 

[2] www.stefanbion.de/evpmaker 

[3] IPATI Bulletin Nr. 23. 

Quelle: www.rait.airclima.ru/multitrack_evp. 
htm

Übersetzung: G. Helzel und S. Bion 


